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1. System configuration
The system configuration of TOP and “Ebm-papst - R3G400-RP45 Series” is as follows:

Communication setting ‘

‘ Link I/F ‘ Communication method

Series ’ CPU
3. TOP communication

setting

4. External device setting

5. Cable table

- RS-485

Ebm-papst R3G400-RP45

B Connection configuration
+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS485 communication.
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2. External device selection

W Select a TOP model and a port, and then select an external device.

Select Device H

PLC select [COM2]

Filter : |[AII] v‘ Search : I:I

@ Model (O Vendor

Vendor
BONGSHIN LOADCELL ¢

FAMUC Co., Ltd.

MINEBEA Co., Ltd.

Azbil Corporation

KORO TECHNOLOGY
ROBOSTAR

CoDeSys Automation Alliance
Ophir Optronics Solutions Ltd.
SERVOMEX

Tiger Optics, LLC

B &R Automation

Peripheral Device

OTHFR S Manufachire

4_Back | B Next *® Cancel

Select Device n

PLC Setting[ Centrifugal fans ]

Alizs Mame @ |PLCL

Interface : | Computer Link ~

Protocol : |ebmBUS Protocol ~ Comm Manual
String Save Mode : |First LH HL Change

[ use Redundancy

Primary Option

Timeout 300 &|| msec
Send Wait msec
Retry 5 =

Faniddress

L&
FanGroupAddress l:l

@ Back + OK * Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.

External device

Vendor Select the vendor of the external device to be connected to TOP.
Select “Ebm-papst”.
PLC Select an external device to connect to TOP.

Interface Protocol
R3G400-RP45 Series Computer Link ebmBUS Protocol

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Option

[ crenoe HM) S

dPLC[Al | THITAl Change PLCIC]

t - TOP Setting !
T X

~ -l Option Module Setting
- FieldBus (0)
-4 RFID (0)
v -\ Device Setting
1g® COM1 ()
~ fg® COM2 (1)
- PLC1: Centrifugal fans
~-tg# COM3 (0)
-l Ethernet ()
29 Wireless (0)
W USBDevice (0)

Date [ Time Sync. = Screen Option

Project Option = Screen Change

Use HMI Setup

FmI SETLp Dpton

] Delete PLCID]

Unit Convert

HmiSetup  Global Lock & Touch

Project Style

Splash

Initialization | Edit |

PLC Buffer Sync.

Project Setting
HMIDisable=0

Project Name=New project
Start Mode=Menu

Start Screen No. =1

Latch Use=0

Latch Set=0~0
Communication Error Message =0
USBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1

A

Control Panel

System m[)evices :naService %'"'_'Dptic-n

o Serial *
-
il ~ .
Serial Port: | COMZ <
PLC Secur ity Dat e/ Time .
Signal Level
() RS-232C () RS-422(4) @ R5-485(2)
Baud Rate: 9600 e
.- 2 B—
(1] i
Data Bit: |8 v
Et hernet Serial HOK | )
Stop Bit: |1 hd
— Parity Bit: |None v
=R
| — ~ Flow: [(ff
. Ping
Diagnost ic File Fing Auto Search LOOpbﬂCk Test
Manager
Apply Cancel
Items TOP External device Remarks
Signal Level (port) RS-485 RS-485
Baud Rate 9600
Data Bit 8
Stop Bit 1
Parity Bit NONE

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [Project > Project Property > Device Setting > COM > "PLC1 : Ebm-papst”]
— Set the options of the R3G400-RP45 Series communication driver in TOP Design Studio.

ERI2 e B X
Touch Qperation Panel

Project Option

- Change HMIH]

“ AddPLC[A] | THITal Change PLCIC)

m Delete PLC[D]

TOP Setting
-3 5Y5 ¢ RD1520%
Option Module Setting
-4 FieldBus (0)
- RFID (0)
L, Device Setting
-fg¥ COM1(0)
~ gl COM3 (1)

PLC Setting[ Centrifugal fans ]
Alizs Name : [PLC1

Interface : | Computer Link ~

Protocol : | ebmBUS Protocol ~

String Save Mode : (First LH HL Change

8 Ethernet (0)
® Wireless (0)
9 USBDevice (0)

I— PLC1: Centrifugal fans

[ use Redundancy

Primary Option
Timeout 200 &1 | msec
Send Wait msec
Retry 5 z
FanAddress IZI
FanGroupAddress IZI

Comm Manual

Apply Close
Items Settings Remarks
Interface Select "Computer Link". Refer to "2. External
Protocol Select “ebmBUS Protocol”. device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device and

sending the next command request.

FanAddress

Individual Fan address (1-31)

FanGroupAddress

Fan Group address (1-255)
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3.2. Communication setting in TOP

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting
M [Main Screen > Control Panel > Serial]

Conitkroll Panel

Serial Port: lCDME "]

Signal Level
() RAS-232C () RS-422(4) @ RS-485(2) ]

Baud Rate: | 4600

|
o || G | Dot Bit: i )
E ﬁ Ethernet Serial Stop Bit: l i ‘v]
. [
-]

Parity Bit: | None

m . | Flow: l Of f

Diagnost ic File lAuto Searchl [Loopback Test]
Manager

[ Apply H Cancel ] —

e )

[System]

Items TOP External device Remarks
Signal Level (port) RS-485 RS-485

Baud Rate 9600

Data Bit 8

Stop Bit 1

Parity Bit None

* The above settings are setting examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

B [Main Screen > Control Panel > PLC]

@ Syste g I
fun Driver(COMZ) | PLC1(Centrifugal fans) |~

n Interface | Computer Link [=]
‘ W] protocol [ ebmBUS Protocol |7
Timecut 300 Ej‘ meec
¥NC i Ej“
Viever r-\‘] Send Wait 0 mseac
] | petey -

Ethernet Fanhddres 1 Ej“

FanGroupd 1 Ej“

Dimgnost ic
||
[Systen] Diagnostic Apply || Cancel
Items Settings Remarks
Interface Select "Computer Link". Refer to "2. External
Protocol Select "ebmBUS Protocol”. device selection”.
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.
SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device and

sending the next command request.

FanAddress Individual Fan address (1-31)

FanGroupAddress Fan Group address (1-255)
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
' . ) 1. System configuration
configuration Connection cable name oK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) oK NG L .
diagnostics 3. Communication setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings OK NG . .
4. External device setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

For more detailed setting method than that described in this example, refer to the PLC user manual.
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5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagram described in this section may differ from the recommendations of “MITSUBISHI Electric Corporation”)

M 1:1 connection

TOP External device
Pin Signal Pin Cable connection Pin Signal Pin
arrangementNote 1) name number number name arrangementNote 1)
RDA 1 3 +)
1 5 > '
° o uf
3 iy
6 9 RDB 4 » 2 (-) 1 4
Based on SG 5
communication SDA 6 — Based on
cable connector 7 communication
front, 8 cable connector
D-SUB 9 Pin male 9 front,
(male, convex) SDB 4-pin male RJ45

(Male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

B 1:N connection — Refer to 1:1 connection to connect in the following way.

TOP . ) o External device Cable connection and signal External device
- Cable connection and signal direction - . -
Signal name Signal name direction Signal name
RDA RTX(+) RTX(+)
RDB RTX(-) RTX(-)
SDA — SG SG
SDB
SG
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6. Supported addresses

The devices available in TOP are as follows:
The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address
range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Device Bit Address Word Address Remark
STATUS 0.00 — OFF.15 0 - OFF get status
EEPROM 20030 _gi:f—, io_g: Réfllja,sv(lj?l\lﬂTE
ASPD 0.00 - 0.15 0-0 get actual speed
TSPD 0.00 - 0.15 0-0 set target speed
RESET 0.00 - 0.15 0-0 software reset
Read-only
Write-only

Status variables

Id | Status variable Bit7 | Bit6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | Bit0
00 | motor status Low Byte BLK | HLL | TFM | FB | SKF | TFT - -
01 | motor status High Byte ESD | AR | Uelow | Uzlow | UzHigh| DRV | | _Erd | lzKign
02 |alarm - - - - - OFF | T_Err | 1zLim
03 |DC link voltage X X X X X X X X
04 |DC link current X X X X X X X X
05 |electronics temperature X X X X X X X X
06 |target value X X X X X X X X
07 |actual value X X X X X X X X
08 | closed-loop/open-loop control X X X X X X X X
09 |direction of rotation X X X X X X X X
0OA | commutation frequency X X X X X X X X
0B | PWM duty cycle X X X X X X X X
0C | operation status X X X X X X X X
0D | PWM frequency X X X X X X X X
OE |operation hours MSB X X X X A X X A
OF |operation hours LSB X X X X X X X X
10 | motor temperature X X X X X X X X
11 | input voltage X X X X A X X A
12 | restart timer X A X X X X X X
13 | input current X X X X X X X X
F1 |software version Byte 1 X X X X A X X A
FZ2 |software version Byte 2 X X X X X X X X
F3 |software version Byte 3 X X X X X X X X
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- EEPROM Register

Addr | Register Bit7 | Bit6 | BitS | Bit4 | Bit3 | Bit2 | Bit1 | Bit0
00 |fan group X X X X X X X X
01 |fan address - - - X X X bt X
02 |operation modes 1 SWV| WU | SR | EIR | SWS|SETUP| | R | RSFro
03 [target value X X X X X X X X
05 | P-factor X A X X X X b X
06 | I-factor bt b s A X X A b4 X
07 | D-factor X X X X X X X X
08 |max. speed MSB X X X X X X X X
09 |[max. speed X X X X X X X X
OA |max. speed LSB X X X X X X X X
0B |max. Duty Cycle X X X X X X X X
0C | min. Duty Cycle X X X X X X X X
0D |start Duty Cycle X X X X X X X X
OE |target value 0 X X X X X X X X
OF [target value 1 X X X X X X X X
10 | operation modes 2 - - - - - - PMul | EEDIP
11 | rating factor X X X X X X X X
40 |EEPROM status - - - - - IN| | GUL1 | GULO
41 | motor design number of poles X X X X X X X X
42 | motor design function - - - - | Stang | KEY | LR | HW
43 | max. admissible Duty Cycle X X X X X X X X
49 | min. admissible Duty Cycle X X X X X X X X
4A | identification X X X X X X bt X
&0 counter DC link overcurrent failure X X X X X X X X
/1 | counter ground leakage failure X X X X X X X X
62 | counter drive failure X X X A X X A X
B3 counter DC link overvoltage failure X X X X X X X X
B4 counter DC link undervoltage failure X X X X X X X X
G5 counter mains undervoliage failure X X ¥ X X ¥ X X
f6 | counter too many auto restarts X X b X X b X X
A7 | counter external shut downs X X X X X X X X
65 counter excessive temp. electronics X * % X X % X X
69 counter excessive Temperaiure maotor }( K x x }( x x }(
BA counter Hall failure / Back EMF failura X X X X X X X X
6B | counter locked motor X X X X X X A X
6D |failure display n High Byte | ESD | AR | Uelow | Uzlow | UzHigh| ORY | | Erd | IzHigh

= Continue to next chapter
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GE | failure display n-1 High Byte ESD | AR | VYelow | UzLow | UzHigh| DRV | | Erd | 'ZHigh
GF | failure display n-2 High Byte ESD | AR |Uelow | Uzlow | UzHigh| DRV || Erd | 'zHigh
70 |failure display n Low Byte BLK | HLL | TFM | FB | SKF | TFT -

71 |failure display n-1 Low Byte | BLK | HLL [ TEM | FB | SKF | TFT - -
72 |failure display n-2 Low Byte | BLK | HLL | TEM | FB | SKF | TFT - -
73 | operation hour counter MSB X X X X X X X X
74 | operation hour counter LSB| X X X X X X X X
75 |reset counter MSB X X X X X X X X
76 | reset counter LSB X X X X X X X X
77 | software reset counter MSB X X X X X X X X
78 | software reset counter LSB X X X X X X A X
80 | manufacturing date code day X X X X X X X X
g1 | manufacturing date code month X X he X X he X X
82 | manufacturing date code year | X X X X X X X X
83 | serial number MSB X X X A X X A X
84 |serial number X X X X X X X X
85 | seral number LSB X X X X X X X X
B6 | max. DC link current X X X X X X X X
87 |max. ambient temperature X X X X X X X X
8A [time 1% commutation X X X X X X X X
8B [time 2" commutation X X X X X X X X
8C |time 3™ commutation X X X X X X X X
8D | deceleration time bt X A A X A A X
8E | commutation start time X X X X X X X X
aF time zero-value detection disabled X X X X X X X X
90 | commutation angle X X X X X X X X
01 angle zero-value detection disabled X X » x b » x b
92 FWM frequency switching point low }( X K x }{ K x }{
03 FWM frequency switching point high X X X X X X X X
04 PWM frequency for high speed X x » X X » X X
95 |acceleration ramp X X X X X X X X
96 |deceleration ramp X X X X X X X X
97 |min. DC link voltage X X X X X X X X
98 |[min. input voltage X X X X X X X X
99 | max. number of auto restarts X X X X X X X X
o]} auto restart DC link overcurrent ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
aB auto restart drive failure ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
Q¢ | auto restart DC link overvoltage ar_ena | ar_ginh | ar_zeit | ar_zeit | ar_zeit | ar_zelt | ar_zeit | ar_zeit
gD | auto restart DC link undervoltage | ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
aF auto restart mains undervoltage ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
aF auto restart overiemperat. electronics | ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
AD auto restart overiemperature motor ar_ena | ar_eginh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
A auto restart locked motor ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
A2 auto restart Hall / Back EMF failure ar_ena | ar_einh | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit | ar_zeit
A3 |gain voltage rm.s. X X X X X X X X
FB |actual operation mode SWV| WU | LIRE - JUST | EREG | STEU | DREG
FC |actual max. duty cycle X X X X X X X X
FD |actual min. duty cycle X X X X X X X X
FE |actual target value X X X X X X X X
FF |actual sensor value X X X X X X X X
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